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JACKET X 3
4
We asked three BERNINA Educators to interpret Kwik Sew #3653 using their favorite
stitching techniques. The result was three very different – but equally enchanting –
variations on this simple serged jacket.
• BUBBLES - Stitch perfect, overlapping “bubbles” with the help of BERNINA
Circular Embroidery Attachment #83 and your favorite decorative stitches. The
ﬂuted sleeve ﬂounces lend a bit of feminine allure to this fun little jacket.
• SERGER STRIPE IT RICH - Jazz up a jacket with rows and rows of serged stripes and
twisted tucks, using decorative threads in coordinating colors. Use the serger for seaming
the jacket pieces together and ﬁnishing the collar, front edges and hem edge, too.
• FLORAL SPIRIT JACKET - DesignerPlus BERNINA Embroidery Software offers the
ability to scan pattern pieces and use them as templates for combining designs and
auditioning placement before sending completed arrangements to the embroidery
system. No more guessing – it’s just that simple!
MINI JEWELRY ROLL
8
Make this small travel accessory with your embroidery machine and BERNINA
DesignerPlus Embroidery Software – no sewing required! This pretty jewelry roll features
three pockets to accommodate a variety of items, and the deepest pocket has buttonholes
sewn across the top edge.

14

Not Your Uncle’s Stamp Collection

SWIRLED & SPIRALED
12 BERNINA makes creating spiraled mats and bowls easy to achieve with uniquely designed
accessories like Double Cording Feet #59 and #60. The technique is simple when you use
the right tools – even children will have fun making little trivets and coasters for quick
gifts.
NOT YOUR UNCLE’S STAMP COLLECTION
14 Use the Carving Stamp, a new feature in v6 BERNINA Embroidery, to create textured ﬁlls
in your embroidery. The resulting designs have lovely texture and visual depth.
BRIGHT BABY BIBS
16 No more dull and boring bibs! These colorful reversible bibs are made from vibrant
toweling and cotton prints. They are just perfect for bottle feeding or protecting your little
one from the dribbly-droolies.
CHENILLE CAT
20 Create easy embroidered chenille with your Explorations Software. How delightful to let
your BERNINA Embroidery System sew multiple rows of straight stitches quickly and
accurately.
LIBERTY SHIRT SLEEVE VENT
23 The Liberty Shirt pattern from Project Sewing Workshop has many unique features, but
one of the best is the deep vent at the bottom of the sleeves.

30

Thread Painted Flower Tote

PATCHWORK POSIES
24 Welcome spring with this lovely machine-appliqued wall-hanging by Beth Ferrier, featuring
her new Wash Away Applique Sheets. Use this unique water-soluble product for the
applique templates, then wash it away or simply leave it in place to soften over time.
WALK BESIDE ME
28 Use BERNINA v6 Embroidery Software to create quilting motifs that make you look like
a pro, and then combine your designs with one of the built-in Diane Gaudynski quilting
motifs from the BERNINA 830 to create this lovely wall-hanging.
THREAD-PAINTED FLOWERS TOTE
30 While getting acquainted with the new BERNINA CutWork Tool and Software, Judy
Hahner experimented with cutting ﬂower shapes out of wool felt and they were starting to
accumulate. The result is this tote embellished with thread-painted cutwork ﬂowers.
FELTED CIRCLE PILLOW
33 A rainbow of colors takes this plain rectangular pillow from boring to jazzy. With the help
of the Needle Punch Tool, you’ll be able to create the irregular circles of yarn and roving
in no time.
EMBROIDERED LEATHER VEST
34 Use My Label 3D Fashion Pattern Software to design and embellish a vest that ﬁts!

Swirled & Spiraled

12
1

needle notes
It’s the middle of winter, there’s snow on the ground (at least for some of us), and
the temperatures are on the chilly side! Let’s stay inside where it’s warm and spend
some quality time with our sewing machines! In this issue of Through the Needle we
have a collection of projects to keep you stitching and embroidering all the way into
spring. We even have a great pattern to help you get started!

Walk Beside Me

28

We asked three BERNINA Educators – Susan Fears, Judy Hahn, and Paula Harmon
– to use Kwik Sew pattern #3653 and give it their own creative spin. The result is
three entirely different interpretations – a delicate black and white version, a comfy
embroidered knit jacket, and one featuring metallic serger embellishments. What
would your jacket look like? Mail in the coupon for a copy of Kwik Sew #3653 and
create your own unique spin on this easy-to-stitch jacket.
This edition of Through the Needle also features all sorts of sewing-related software
– BERNINA Embroidery Software versions 5 and 6, My Label 3D Fashion Pattern
Software, Explorations, and the new CutWork Tool and Software. Chris Wiegers’ Mini
Jewelry Roll is perfect if you’d rather spend time with your computer and embroidery
system than with your sewing machine – it’s completely embellished and constructed
in the embroidery hoop!
Looking for basic sewing projects? The bibs and bowls and pillow projects are all
simple enough for children to stitch, but make great-looking gifts that anyone would
love. And for the quilter we have an easy appliqué wall-hanging from Beth Ferrier.
It’s sure to make you feel like spring is on the way!
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spotlight on…
Silk, Silk and More Silk
A lot of talent and work is involved in packaging just the right
silk for patterns and projects. The Sapphire Sea Silk Collection
is the latest silk collection that has been teamed with a Blue
Underground pattern. This collection is a beautiful play on
iridescents, sapphires, aquas and other hues from the sea.

Berkeley Blue from Blue Underground Studios, Inc.
Berkeley Blue is a square upon square upon square that
equals a harmony of dimension and depth. Designed by Amy
Walsh, the ﬁnished quilt measures 54” x 63” and is gorgeous
enough to display on a wall. Amy, a former junior high history
teacher, decided to turn her weekend and evening hobby and
turn it into the business Blue Underground Studios, Inc. with
partner Janine Burke. With a Sapphire Sea Silk Collection and
the Berkeley Blue Pattern, you too can create this stunning
masterpiece.

Time to Quilt
Why not take a break to create this wonderful, inspiring quilt
– perfect as a gift and maybe even too pretty to give away.
Inquire at your local independent shop about this Brewer
Quilting & Sewing Supplies exclusive silk collection today.
Amaze your friends with the result.
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We asked three BER
BERNINA
RNINA Educators to interpret
t Kwik Sew #3653 using
their favorite stitching techniques. T
The result was three very different –
but equally enchanting – variations on this simple serged jacket.

SPECIAL OFFER!
KWIK SEW Pattern #3653
Misses’ Jackets

KWIK SEW Patterns has an exclusive offer
for Through the Needle readers. Purchase a copy
of KWIK SEW Pattern #3653 Misses’ Jackets
for the special reader price of $3.99
a retail value of $11.49.
Complete the following form and mail it with a check
or money order for $3.99 payable to “KWIK SEW”:
KWIK SEW Patterns
Dept Bernina of America, Inc.
3000 Washington Ave. N
Minneapolis, MN 55411

Pattern Number: #3653 Misses Jacket
Name (PRINT): ______________________________________________________
Address/Apt.: _______________________________________________________
City: _________________________________ State: ____ Zip Code: __________
Phone: _____________________ E-mail: _________________________________
Please print. Photocopies accepted. No phone or internet orders accepted.
Limit one offer per household/address. No product substitutions. KWIK SEW is
not responsible for lost or illegible mail. Offer not valid where prohibited by law.
Questions may be submitted by mail to KWIK SEW at the address provided.

KWIK SEW
®

Please send me KWIK SEW pattern #3653 for only $3.99!
Cost of pattern includes shipping and handling fees.

Offer expires June 30, 2010
Valid in the USA Only
For more information visit kwiksew.com

I S S U E

Bubbles
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BY SUSAN FEARS

Stitch perfect, overlapping “bubbles” with the help of BERNINA
Circular Embroidery Attachment #83 and your favorite
decorative stitches. Serger flatlocking joins the panels for added
graphic punch and outlines the collar edges. The fluted sleeve
flounces lend a bit of feminine allure to this fun little jacket.
When all circles are stitched as desired,
wash out the stabilizer and press each
linen piece. Position a pattern piece on
each embellished rectangle and cut out, but
do not cut Lower Sleeve #9 at this time.

Jacket Assembly
Decorative Stitch Embellishment
Position the pattern
pieces on linen fabric
and cut out each one at
least 1" away from the
actual cutting lines.
Use Best Press fabric stiffening spray to
stabilize the linen. Place a piece of Aqua
Tear Biodegradable stabilizer under the
linen and temporarily bond the layers
together with 101 Quilt Basting Spray.
Attach Circular Attachment #83 to the
sewing machine following the package
instructions.
The Circular Attachment causes the fabric
to pivot around the center pin in a circular
direction. This attachment works with all
stitches except multi-directional stitches
and can sew circles up to 10” in diameter.
Attach Clear Embroidery Foot #39/39C to
the sewing machine.

Set up serger with black thread for a
4-thread overlock stitch. For the sample
jacket the stitch length was adjusted to 2
rather than the recommended 2.5 setting
for the overlock stitch.
Serge jacket panels together following the
pattern instructions.
Fluted Sleeve Variation
Cut a half circle of linen instead of the
lower sleeve (pattern piece #9). Make the
inner curve about 1½" wider than the inner
curve of the original pattern piece. Place
the outer circle about 5½" from the inner
circle, creating a 5½" wide circular lower
sleeve piece. Cut two flounces – one for
each sleeve.
Tip: Use the
Cut-A-Round
Tool by Phillips
Fiber Art for
ease in cutting
curves.

Select from the wide range of decorative
stitches on the BERNINA sewing machine
to embellish the linen pieces with circular
intersecting patterns. Select stitch patterns
that are more open rather than heavier
patterns with satin stitching.

Fold the fabric in half and press to form
a crease. Fold each section in half and
press; there are now three pressed lines,
forming four sections. Continue folding and
pressing in this manner until there are 15
folds and 16 sections.

Stitch full and
partial circles
on each pattern
piece, varying
the circle sizes
from 3” to 7” in
diameter.

Thread the
sewing
machine with
black thread in
the needle and
bobbin. Attach
Edgestitch Foot #10/10C to the machine.
Move the needle position 1 to 2 spaces
to the left. Guide the blade of Edgestitch
Foot #10/10C along each fold in the lower
sleeve, forming tiny tucks. If the tucks ripple
as they are sewn, reduce the presser foot
pressure 1 to 2 increments.

Tip: When beginning a circle that
intersects with another circle, begin at the
intersection. This makes it easy to conceal
starting and ending points should they be
less than perfect.

At the serger, finish the
lower edge and both
sides of each lower
sleeve panel with the
rolled hem stitch. Use
a seam sealant such as
Fray Block™ to seal the
exposed edges.
The inner edge of the lower sleeve panel
should be the same length as the inner
edge of pattern piece #9. If the tucks did
not take up enough fabric, the edge will
be too long to easily join to the mid-sleeve
section. In this case, gather the inner edge
of the fluted sleeve to remove the excess
fabric.
Join the fluted cuff to
the mid-sleeve section
of the jacket following
the pattern directions,
overlapping the side
edges.
It’s a good idea to
edgestitch the serger
seam to hold it flat since
the fluted sleeve is a bit
bulkier than a flat panel.
Collar Variation
Omit the serged edge
around the jacket
shown in View A,
Step 8. Instead, attach the collar and finish
the edges in one step at the serger as
detailed below.
Sew the collar center back seam and fold
the collar in half, wrong sides together. Lay
the folded collar on the wrong side of the
jacket, tapering the collar to nothing at the
notch.
Set up the serger for a 4-thread overlock
stitch with white thread in the needles and
loopers. Attach the collar to the jacket.
Attach the sleeves following the pattern
instructions.
Thread the serger with black thread; serge
all the outer edges.
5

Floral Spirit
Jacket
BY JUDY HAHNER

Embroidered panels add interest to this very simple serger jacket.
DesignerPlus BERNINA Embroidery Software offers the ability to scan
pattern pieces and use them as templates for combining designs and
auditioning placement before sending completed arrangements to the
embroidery system. No more guessing – it’s just that simple!
templates to attach a placement sticker
marking the center of the hoop for help
with positioning the hoop for perfect
embroidery placement.

The designs used for this jacket are from
Studio BERNINA® Design Collection
Vol. 8 – Spirit of Geometry (BE10813.ART,
BE10839.ART, BE10841.ART).

Stitch the Designs

Plan the Embroidery Layout
Scan the pattern pieces so you to can
perfectly place the embroidery designs in
the hoop:
• Open the BERNINA® Embroidery
Software.
• Select Art Canvas (Picture View in v5).
• Select Scan; scan the following pattern
pieces: Upper Front, Upper Back neckline
edge, Lower Front curved front edge
• Select to save to a folder named Serger
Jacket.
In Embroidery Canvas (Design View in v5),
open a NEW file.
• Select Art Canvas (Picture View in v5).
• Select Load Picture and select one of the
scanned pattern pieces.
• Select Import; press Enter on the
keyboard to view the scanned image on
the screen.
• Select Embroidery Canvas (Design View
in v5).
• Select Show Hoop and select the
255 x 145 Oval Hoop.
• Select File > Insert Design. Locate the
Spirit of Geometry designs for that piece
and click Open.
Position designs on each pattern piece
and arrange them in pleasing patterns. Use
the images of each section, below, as a
reference for placement.

• Select Edit > Select All. Select the Color
• Selection Bar and Color C43.
• Select File > Save As. Name the design
files. Select Write to Machine and send
the files to your BERNINA embroidery
system or media (card, USB stick).
For complete step-by-step software
instructions, visit www.berninausa.com.

Prepare the Fabric Pieces
Cut pieces of fabric large
enough to accommodate
the Upper Front, Upper
Back and Lower Front
sections of the jacket, and
allow enough extra fabric
to easily hoop these pieces. Use a chalk
marker to trace around each pattern piece
on its fabric piece, taking care to follow
grainline placement. Use these lines as
guides for embroidery design placement.
You will re-cut the jacket pieces on the
marked cutting lines after completing the
embroidery.
Cut the remaining jacket pieces following
the layout guide included with the pattern.

Prepare for Embroidery
Stabilize the knit fabric pieces that will be
embroidered by pressing a piece of Armo®
Weft fusible interfacing to the wrong side.
Hoop the prepared fabric
with two layers of OESD
PolyMesh Cut-Away
stabilizer. Use the hoop
templates and design

6

Prepare and embroider
the Upper Front,
Upper Back, and
Lower Front sections
of the jacket using
Isacord embroidery
thread. When embroidery is complete, trim
away the excess stabilizer.
Using the paper patterns as a guide, cut
out the Upper Fronts, Upper Back and
Lower Front sections of the jacket from the
embroidered fabric sections.

Prepare the Serger
The exposed jacket seams, lower sleeve
edges, and jacket edges offer a wonderful
opportunity to visually tie together the
embroidery and overlock stitching. The
overlock stitches serve a dual purpose –
joining the jacket sections and embellishing
the seams.
Set the serger for a wide 3-thread overlock.
Thread the needle with thread to match
the jacket fabric, and the lower looper with
thread to match the embroidery.
The upper looper thread will be visible on
the right side of the jacket. To create the
appearance of a two-tone thread, combine
two strands of Isacord embroidery thread in
the upper looper – one darker than the needle
thread and one darker than the lower looper
thread. When threading the serger, treat the
two threads as one and thread them together
through the upper looper thread path.
Complete the jacket as directed in the
pattern guide sheet.

I S S U E
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Serger Stripe
It Rich
BY PAULA HARMON

Jazz up a jacket with rows and rows of serged stripes and twisted tucks,
using decorative threads in coordinating colors. Use the serger for
seaming the jacket pieces together and finishing the collar, front edges
and hem edge, too.

Decorative threads used in this
project:
• Razzle Dazzle by Ricky Tims
• Glamour No. 8
• Halo Decorative Serger Thread
• Pearl Crown Rayon
• Candlelight

Left Front Twisted Tucks
Adjust the serger for a wide, 3-thread
overlock stitch. Thread the loopers with YLI
Candlelight Blue in one looper and Gold in
the other, resulting in tucks that are blue
on one side and gold on the other. On the
BERNINA 1150MDA serger used for this
sample, the cutting blade was set on 2 to
yield a ¼"-wide stitch. When serging, guide
the fabric just inside the knife blade.
Run a test stitch to confirm that you are
pleased with the color choices. Balance the
tension as needed; the two looper threads
should meet and loop together exactly at
the fabric edge.
Cut a rectangle of dark brown fabric
2" longer and twice as wide as pattern piece
#2. Using the water-soluble pen/pencil,
mark the fabric with vertical lines spaced
2" apart. Fold along the first marked line
with wrong sides of the fabric together. Line
up the pressed fold with the very edge of
the serger bed and stitch the first tuck.
Continue folding and serging
until you have a rectangle of
fabric that is large enough for
one of the jacket center-front
panels. Do not cut the panel
yet. Press all tucks in one direction.
Next, attach the quilt guide to the right side
of Walking Foot #50. Adjust the guide so it
is 1½" from the center of the foot. Thread
the needle and bobbin with thread that will
blend into the brown fabric.

Stitch 1½" from the
upper edge of the
tucked rectangle,
stitching across the
tucks to hold them in
place. Turn the tucks in
the opposite direction,
pin and stitch across
the fabric rectangle again, 1½" from the
stitching previous line, in the opposite
direction from the first row of stitching.
Repeat the tuck twisting and stitching until
the entire panel is covered with alternating
tucks.

Right Front Serger Cording
With the serger still threaded with the
decorative threads used for the serger
tucks, simply “step on the gas” and stitch,
pulling the length of chain from the back of
the serger. You’ll need approximately 100"
of cording for this project.
Fold the length of serger chain in half
and twist it together lightly to create the
cording.
Attach Braiding Foot #21/12C to the
sewing machine.
Trace the center-front pattern piece onto a
piece of fabric using the water-soluble pen/
pencil. Mark vertical lines 4" apart across
the panel.
Prepare your sewing machine with
monofilament thread in the needle and
Isacord that matches the fabric in the bobbin.
Adjust the machine for a short zigzag stitch
(1.5-2mm long) with a width of 3-5mm.
Guiding the cord through
the circular guide in
the center of Braiding
Foot #21/12C, couch
the cording over the
marked lines on the fabric

rectangle, adjusting the stitch width as
needed to completely cover the cording.
Repeat until all marked lines are couched.

Jacket Back and Sleeves
Flatlock Piecing
Thread the serger for a wide, 2-thread
flatlock stitch with contrasting Isacord
embroidery thread in the looper and
matching Isacord in the needle. Set the
needle tension at 1 to 2 and the looper
tension at 6 to 7. Set the stitch length at
2mm and sew a test swatch along a fabric
fold in a scrap, making sure that the knife is
cutting approximately 1/8" off the edge.
Cut a strip of dark brown fabric 2" longer
and twice as wide as pattern piece #5
(center-back strip). Cut two additional
strips of dark brown fabric 2" longer and
twice as wide as pattern piece #8 (center
strip of the sleeves). Using a water-soluble
pen/pencil, mark vertical lines 2" apart
across the width of each panel.
Fold the fabric rectangle along one of the
marked lines, wrong sides together; press.
Stitch along the fold, carefully cutting
approximately 1/8” off the edge.
Once the flatlock row has been stitched,
simply pull the fabric on each side away from
the seam, pulling the stitch open and flat.
Stitch every other marked line in this manner.
Rethread the serger with a heavy
decorative thread in the lower looper
(sample uses Razzle Dazzle by Ricky Tims).
Sew another test swatch, adjusting the
stitch length and tensions as needed.
Repeat the folding and serging
process on all three panels.
Cut the serged pieces using
the appropriate pattern pieces
and complete the jacket following the
pattern instructions.
7

Jewelry Roll
MINI

BY CHRIS WIEGERS

SUPPLIES

• BERNINA DesignerPlus
Embroidery Software
• BERNINA sewing and
embroidery system
• Large Oval Hoop
• Freemotion Couching
Foot #43
• Edgestitch Foot
#10/10C/10D
• Silk dupioni
- Outside: 10” x 15”
- Lining: 6” x 11”
- Small Pocket: 6” x 8”
- Medium Pocket: 6” x 11”
- Large Pocket: 6” x 14”
• OESD PolyMesh Stabilizer
• Hilos La Espiga Nylon
Cording
• 24”-long piece of
1”-wide ribbon
• Thread to match cord
and fabric
• Darning needle

8

Make this small travel accessory with your embroidery
machine and BERNINA DesignerPlus Embroidery Software –
no sewing required! The cording is applied to the surface with
the embroidery machine and the basic construction is all done
in the hoop! This pretty jewelry roll features three pockets to
accommodate a variety of items, and the deepest pocket has
buttonholes sewn across the top edge. To avoid tangling of
your necklace chains, fasten them through the buttonholes
before you drop them in the pocket.
The attached ribbon is tied
around the bundle to
keep everything
secure.

I S S U E

CREATE THE DESIGN

Open the DesignerPlus software and open a new, blank
design.
Right click on the Show Hoop icon and select the artista
255 x 145 Oval w/Grid hoop from the menu. Select Manual
in the Position box. Make sure that the Display Hoop box is
checked. Click OK.
Click on the Show Grid icon to turn off the background grid,
so that you will see only the grid that is part of the hoop
display.
Select the Closed Object tool and then the Stipple icon.
Create an oval shape that is just inside the dashed line that
indicates the boundary of the stitching area of the hoop.
Click on the Select Object icon. The stippled object should be
selected. If it is not, click on it to select it.
Right click on the stippling to open the Object Properties
box. Change the Loop Spacing to 10mm (0.4”) and the Inset
Step to 2. Click Apply and check to be sure that the distance
between the stippling and the stitching area boundary is
about one grid square. If it looks too close to allow for the
extra size of Free-motion Couching Foot #43, increase the
Inset Step to 3. Click OK.

Because the sole of Foot #43 is so much larger than the
embroidery foot, the portion of the design that will be
couched must not fill the entire hoop; otherwise the foot
will run into the hoop. Keeping the couched design
about 3/8” inside the normal hoop boundaries
allows you to safely stitch the design inside the
hoop.

With the Open Object tool still selected, choose a third color
from the Color Bar. Create a short line of stitches along the
grid line four squares below the center line, placed between
the seam line and the hoop boundary. This will be a placement
mark to help position the pocket before the seam is sewn.
Make additional placement
marks at the center grid line, four
squares above the center, and
corresponding positions on the
other side of the hoop. Also make
a placement mark at the center top
of the hoop to serve as a guide for placing the ribbon. The
arrows in the illustration indicate where to place the seven
marks. Be sure that the
marks are entirely outside
the seam line, or they will
be visible in the finished
project.
As arranged now, the placement lines would
stitch after the seam line, but they need to
stitch before the seam line. If Color Film is
not displayed at the right side of the screen,
click on the Color Film tab at the right side of
the screen. If the tab is not visible, click on
the Color Film icon on the General Toolbar. To
change the stitch order, click on the third color
square and drag and drop it between the first
and second squares.
Save your design and transfer it to the embroidery system for
stitching.

PREPARE THE POCKETS

Fold the pocket pieces in half, wrong sides together, and press.
Sew three buttonholes
(approximately 16mm long)
near the fold of the largest
pocket, spacing them 1”
apart. (See page 10 for a fun
alternative that stitches the
buttonholes in the hoop.)

Note for BERNINA 830 Owners: Select the
Presser Foot Indicator in the embroidery
screen to tell the 830 that you are using the
#43 foot.
For Version 5 BERNINA Embroidery
Software Owners:
Create the oval area as a Step Fill object, then
convert to stippling. Make the oval smaller
(about 1 grid square away from the stitching
boundary), since v5 places the stippling all the
way to the edge of the defined area.

Select the Open Object tool. Select Single from the
list of outline types and choose a new color from
the Color Bar. (It doesn’t matter which color you
choose; assigning a different color creates a
stop between steps.) Create a line approximately
half a grid square inside the stitching boundary,
leaving a gap about 6 squares wide. This line will
be the seam line, and an opening must be left in
the seam for turning the piece inside out.

33

STITCH THE DESIGN

Hoop the outer fabric with one layer of PolyMesh stabilizer.
Attach Free-motion Couching
Foot #43 to the machine.
Pull the cord into the foot as
directed in the instructions
provided with the foot.
Thread the machine with
thread that matches the cord.
Adjust the machine tension to the setting you would use for
normal sewing. (Embroidery is usually stitched with a lowered
needle tension, but a balanced tension is better for this step.)
9
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Sew the first step of the design. Do not cut
the tail of the cord, but be sure that it stays
out of the way of the stitching.
Remove the hoop from the machine. (Do
not take the fabric out of the hoop.) Use a
darning needle to pull the cord ends to the
wrong side; tie them off. Be very careful not
to push too hard on the fabric or it may become distorted or
pull out of the hoop.
Return the hoop to the machine, attach the normal embroidery
foot, and stitch the placement marks.
Remove the hoop from the machine. Align the
folded edge of the small pocket with the lower
set of placement marks. Pin in place, being
sure that the pins are very close to the hoop
and will not interfere with the stitching of the
seam line. (If you prefer, tape the pockets in
place.)
Align the medium pocket with the center set of
placement lines and the large pocket with the
upper set.
Fold the ribbon in half and pin the fold in place
over the placement line at the top of the hoop.
Place the lining over everything, right side
down. Note: Be sure that the loose ends of the
ribbon are tucked inside so they won’t be caught in the seam.

Remove the hoop from the machine and the fabric from the
hoop. Trim away the excess fabric, leaving a seam allowance
of about ¼” wide. Clip the curves if necessary, and turn the
project right side out. Press.
Attach Edgestitch Foot
#10/10C/10D to the sewing
machine. Adjust the needle
position to the left of center
and topstitch around the entire
oval, stitching the opening
closed. (If you prefer, stitch the
opening closed by hand.)

CHRIS WIEGERS
Chris teaches sewing, quilting, and
machine embroidery classes, primarily
for BERNINA dealers near her Nebraska
home. Her specialty is BERNINA
Embroidery Software, having worked with
every version of the software since the very beginning.
She is currently enjoying the great new features of
Version 6, and is particularly excited about all the
possibilities opened up with the addition of CorelDRAW
Essentials 4. Chris has a degree in what used to be
called Home Economics, with an emphasis in textiles
and fashion design. Visit her galleries and read her blog
at www.chriswiegers.com.

EMBROIDERED BUTTONHOLE OPTION
To add extra pizzazz, embellish the pockets with a little
embroidery, incorporating the buttonhole stitching with the
embroidery!

Click on the grid line two squares left of center, about one
square down from the placement line just created. Move the
mouse to the right until the third buttonhole is right over the line
two squares to the right of center; click.

EXTRA SUPPLIES FOR EMBROIDERED BUTTONHOLES
• Medium Hoop
• Self-adhesive stabilizer, such as OESD Stabil-Stick or
AquaMesh Plus

Choose Insert Design from the File Menu. Select My Designs
v6 > Ornaments > Gilded Silver 2. Position the design to the
left of the buttonholes.

CREATE THE BUTTONHOLE DESIGN
Open the DesignerPlus software and open a new, blank design.
Right click on the Show Hoop icon and select the artista 130 x
100 w/Grid from the menu. Select Manual in the Position box.
Be sure that the Display Hoop icon is checked. Click OK.
Click on the Show Grid icon to turn off the background grid.
Select the Open Object tool and create a horizontal line of
Single stitches somewhere in the upper half of the hoop. This
will be the placement line for the pocket.
Select Add Buttonholes from the Arrange Menu. Choose 3 for
the Number of Buttonholes. Click OK.
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Return the hoop to the machine and stitch the last step with
thread that matches the fabric.

With the design still selected, click on
Mirror-Merge Horizontal and place
the second design to the right of the
buttonholes.
To stitch the design in the same color as the buttonholes,
select both and choose the desired color.
STITCH THE BUTTONHOLE DESIGN
Hoop the stabilizer, paper side up. Sew the placement line, and
then remove the paper below the line. Stick the pocket to the
stabilizer, aligning the fold with the placement line. (Keeping
the pocket in place is easier if the two layers of the pocket are
bonded together with a light spray of temporary adhesive.)
Stitch the design.

Form wrapped cord into flower petals for
unique bowl embellishments. (Made by
Janeen Veleez)

BY DENISE FISCHER

Swirled
Swirl
Sw
rled
d&
Spiraled
Sp
Express your imagination and creativity as you fashion
these spectacular gifts for holidays and special occasions.
BERNINA makes creating spiraled mats and bowls easy
to achieve with uniquely designed accessories like Double
Cording Feet #59 and #60. The technique is simple
when you use the right tools – even children will have
fun making little trivets and coasters for quick gifts.

Supplies
• 1 package of cotton clothesline (from your
local hardware store)
• BERNINA sewing machine
• Double Cording Foot #59 or #60
• Topstitch needles, size 90/14
• Quilting needle, size 90/14 or Universal
needle, size 90/14
• Scraps of woven cotton fabrics; batiks
work especially well because they resist
fraying
• Isacord embroidery thread or other
decorative thread
• Gluestick
• Wooden clothespin

Directions
Cut assorted strips ¾" to 1" wide.

Start by dabbing the gluestick on the
wrong side of a fabric strip, covering
the first 2" at the starting end of the
strip. Fold the tip of the strip around
the clothesline and start winding strips
around the cord. Use a clothespin to
hold the end of the strip in place as
needed.
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Begin creating a spiral, wrapping the
cord in a circular motion to create the
base of your project.

Attach Double Cording Foot #59 or
#60 to the sewing machine, and place
the coiled cord under the grooves in
the sole of the foot. Select a zigzag

Make two bowls, one slightly smaller than the other, and use the smaller
one as a lid to make an interesting container for collecting odds and ends.
(Made by Denise Fischer)

Join three white circles in
graduated sizes to make a
cheery snowman. Use Button
Sew-On Foot #18 to attach
button accents. (Made by
Denise Fischer)

Stitch four wrapped cords together to make
a handle for a colorful autumn basket; fill with
pinecones or colorful leaves for a decorative
home accent. (Made by Denise Fischer)

stitch or a three-step zigzag stitch; the
length and width depend on the look
you want, but must be wide enough
to catch both sides of the cord. Stitch,
joining the cords as you go.
Continue adding strips, applying glue
to the ends and wrapping them around
the cord. At the same time, continue
spiraling the cord and stitching it in
place.
Flat coiled pieces are easy to make.
For a coaster, keep sewing spirals until
you have a circle about 5" in diameter.

For a trivet, make a circle about 12"
in diameter. Sew off, leaving a 1"-long
fabric tail. Tuck the tail under and stitch
it in place to finish the edge.
Add a third dimension to your technique
by creating free-form three-dimensional
shapes, turning a trivet or coaster shape
into a bowl, basket, or tote bag. Begin
with a 6"- to 8"-diameter base and
bring the spiral-wrapped clothesline
toward the top of your sewing machine.
Continue stitching until the sides are the
desired height.

13

Not Your Uncle’s

BY DEBBI LASHBROOK

Use the Carving Stamp, a new feature in v6 BERNINA
Embroidery, to create textured ﬁlls in your embroidery.
The resulting designs have lovely texture and visual depth.

Preparing the Artwork
Open a New file. Select the artista 255 x 145 Hoop.

There are three ways to add stamps to the background fills:
using an object, using a pattern, and digitizing a stamp.

Switch to Art Canvas mode.

Using an Object
This technique is shown on the large oval.

Click on the Basic Vector Shape icon.
Select File > Insert Design.
Click on the Perfect Shape icon
located on the Property Bar. Click on
the black triangle in the corner of the
icon to access a variety of shapes.
You can also draw shapes with the
Object Tools.
Draw various shapes with the Object
tools or the Shapes tools. Use the
illustration as a guide, or create your
own design.
Fill the objects with color by clicking on the color chips on the
right side of the screen while the object is selected.
Select Ctrl + A to Select All.
Click on the Convert to Embroidery icon.
Switch to Artistic View if necessary by using the shortcut
key “T” or by clicking on the Artistic View icon.
Open the Carving Stamp window. If it does not stay
open, dock (“thumbtack”) it in place.
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Navigate to My Designs Embroidery Software 6 > Florals and
select FP953. Click and drag the design away from the Art
Canvas designs. Ungroup the design.
Use the Polygon Select tool to choose the part of the design
to be used as a stamp by clicking around the area, then hitting
Enter to close the area around the design.
While it is selected, Group the design. Click and drag it away
from the other parts of the design.
Draw a bounding box around the remaining parts of the design
to select them; delete.
Click on the Use Object tab in the carving
dialog box. Click on Start Selecting and
draw a bounding box around the part of the
design to be used as a stamp. Press Esc.
Draw a selection box around the remainder
of the design – the part that was used for the
stamp – and delete.
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Stamp Collection
Click on Use Stamp. Stamp one object in your design; click once
to anchor the shape, then move the mouse to a new position
and click again to position the shape. Hit Esc to deselect the
stamp.
If desired, change the background fill by selecting the object and
opening Object Properties. In the sample, the large oval fill was
changed to Step Fill 4 and the Spacing to 0.5.

Finishing the Stamped Designs
Follow these steps to complete the design as shown.
Second Small Oval: Convert the background fill to Satin stitches.
Following the steps for Using a Pattern, create a stamp using
Home Dec stitch #414, and then stamp the oval.
Medium Oval: Create a stamp using Home
Dec stitch #412, and then stamp the oval.
Select the oval, click on the Appearance
tab, and select Raised Stamp.

Using a Pattern
This technique is shown on the large rectangle.
Click on the Use Pattern tab in the Carving
Stamp dialog box. Select Carving Stamps
from the Set drop-down menu choices.
Select Ring Ellipse.
Stamp the large rectangle. Press the Esc
key on the keyboard.
If desired, change the background fill by
selecting the object and opening Object
Properties. In the sample, the large
rectangle fill was changed to Step Fill 24
and the Angle to 90 degrees.

Digitizing a Stamp
This technique is shown on the large triangle.
Click on the Digitize tab in the Carving
Stamp dialog box. Click on Start Digitizing.
Create a stamp pattern by drawing on
the screen using left (straight) and right
(curved) clicks. To digitize a closed stamp,
click on top of the first click. Click Enter to
complete the stamp, and then click ENTER
again to place the stamp in the window.

Small Rectangle: Change to Fancy fill 143.
No stamp applied.
Small Triangle: Change to Step fill 9.

Completing the Embroidery Design
Select Hoop Layout mode, select the hoop by clicking on it, and
then click on the Rotate Hoop icon two times.
Return to Embroidery Canvas mode.
Select the Rectangle tool, click on the Outline button, and then
select Backstitch from the drop-down menu choices. Draw a
rectangle around the design.
Select the rectangle, open Object Properties, select the General
tab, and then change the Width to 287mm and the height to
118mm.
Select Edit > Select All. Open Object Properties. Click on Effects.
Click on the Others tab and change the Pull Compensation to 0.4.
Save the design.

Click on Use Stamp. Stamp the large
triangle. Press the Esc key on the keyboard.

Saving Stamps
To save your newly created stamp for future use:
• Click on Add to Library
• Click on New Set
• Name the set (do not use spaces or punctuation)
• Click OK
• Press Enter
The stamp is now located under the Use Stamp tab.

15

Bright Baby Bibs
BY ERIKA MULVENNA

No more dull and boring bibs! These colorful
reversible bibs are made from vibrant
toweling and cotton prints. They are just
perfect for bottle feeding or protecting
your little one from the dribbly-droolies.

Accessories
• Jeans Foot #8
• Walking Foot #50 (Optional)

Pattern
Enlarge bib pattern 200% (resulting pattern will fit on a single
sheet of legal-size paper). Pattern includes ½" seam allowance.

Materials for 2 bibs
• One purchased cotton kitchen towel, or 3/8 yard cotton toweling
• One colorful cotton fat quarter, or 3/8 yard bright cotton print
• One yard lightweight fusible interfacing
• Matching thread for construction
• Contrasting thread for
topstitching
• Snap closures

Tools
• Pins
• Scissors
• Sewing machine
• Snap attachment tool
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Enlarge 200%
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Directions
Prewash all fabrics to preshrink; this is especially
important with the cotton toweling.
Using the pattern provided, cut one piece from
toweling, one from the cotton print, and one from
interfacing.
Following the manufacturer’s instructions, fuse the
interfacing to the wrong side of the cotton print.
This helps to give the bib a little extra body, and
strengthens the areas where the snap closures will
be attached.

Trim the seam allowances to ¼". Clip curves close to
stitching. Notch out fullness in outer curved areas.

Pin the bib pieces right sides together. Pin well to
help keep the toweling from shifting while stitching.
Turn the bib right side out through the opening. Use
the blunt end of a chopstick or the eraser end of a
pencil to help turn the corners smoothly.
Press the bib carefully along the outer edges, turning
the seam allowances at the opening to the inside. Pin
the bib layers together all around the edge to help
keep the layers from shifting while topstitching.

With toweling side up, stitch around the bib, using a
½" seam allowance and leaving a 3" opening along
one long edge for turning. If you have Walking Foot
#50 for your sewing machine, use it to keep the
layers from shifting while stitching. Or, use Jeans Foot
#8 to handle the thick layers, and pivot around the
curves and corners.
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To finish, add snap closures to the ends of the bib.

Topstitch the bib, sewing close to the outer edge.
Use Walking Foot #50 to keep the layers from shifting
while stitching. Or, use Jeans Foot #8. A triple
straight stitch shows up great against the toweling
and adds a nice finishing touch.
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Chenille

CAT
BY BUNNY GATES

Create easy embroidered
chenille with your Explorations
Software. How delightful to
let your BERNINA Embroidery
System sew multiple rows of
straight stitches quickly and
accurately. Use the chenille
cat as an appliqué or stitch it
directly to you project.

Supplies
• Explorations software (Galaxy
version or Classic version with
Reshape Option)
• Gingher® Knife Edge Appliqué
Scissors
• Olfa® Chenille Cutter or Clover®
Slash Cutter
• Open Embroidery Foot #20/20C
• OESD AquaFilm Topping Water
Soluble Stabilizer
• OESD Lightweight TearAway
• 101 Quilt Basting Spray
• Base fabric large enough to hoop
• 4 or more 7” x 7” or larger
rectangles of coordinating fabrics
• Large Oval Hoop
• BERNINA embroidery system
• BERNINA sewing machine
20

Create the Chenille Cat
Embroidery
1. Create a New Project
• Open Explorations software
• Click on Projects Mode
• Click on New, name the file Chenille Cat and
click on OK
• Articles Mode opens
2. Add the Article
• Click on Pictures
• Place the cat picture on your scanner
• Click on Scan

3. Create the Grid
• Click on View and Show Grid
• Click on Tools and Options
• Type .25 for the Horizontal Spacing and the
Vertical Spacing
• Put a check mark in the Snap to Grid box
• Click on OK
4. Make the Chenille Lines
• Click on Cookie Cutters Mode
• Open the Shapes folder
• Drag and Drop the Straight Line onto the
workspace
• Click on Edit and Rotate Left
• Click on Edit and Rotate Left again
• Place the line 2 lines above the ear of the
cat and change the length of the line to be
about 4 grid squares wider than the cat on
both sides of it
• Click on Stitches n Effects Mode
• Under Outlines, click on Triple Run
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• Click on Edit and Duplicate
1. Click on Edit and Mirror Horizontal
2. Drag it down to the line just below the
first line
3. While this line is selected, click on Edit
and Duplicate
• Repeat steps 1, 2, and 3 above until all grid
lines are covered up to 2 lines below the
bottom of the cat
• Click on Edit and Select All
• Click on Edit and Rotate Left 45
• Click on Group and Group
• Click on View and click on Show Grid until
there is no mark next to Show Grid

5. Remove the Excess Stitches from
Around the Cat
• Click and Drag the Square Cookie Cutter
onto the workspace
• Increase the size of the square until it
completely covers all of the Chenille stitches
on the workspace
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• Drag the
Chenille
stitches
away
from
the cat
picture
• Click on Cookie Cutters Mode
• Drag and Drop the Oval from the Shapes
folder onto the cat shape
• Click on Zoom and zoom in on the cat
shape
• Click on Edit and Reshape
• Reshape the oval into the cat shape
• Click on Stitches n Effects Mode
• Click on Tatami Fill Stitch

• Place the cat shape in the center of the
square shape
• Click on Tools and Remove Overlaps
• Delete the cat
• Move the Square over the Chenille stitches

• Click on Stitches n Effects Mode
• Click on Tatami Fill Stitch
• Click on Tools and Remove Overlaps
• Click on Stitches n Effects Mode and click
on Satin Outline

• Drag the Square over to a clear area of the
workspace, away from the Chenille stitches
21
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• Click on an empty space on the
workspace
• Click on the Satin Square to select it and
click on Delete
• Click on the cat satin stitches and click
on Single Run Outline
• Click on Threads Mode; click on a thread
color in the Thread Chooser box that is
different from the Chenille stitches
• Click on Copy
• Click on Paste
• Click on a new thread color in the Thread
Chooser box
• Click on the Stitches n Effects Mode and
Satin Outline

Stitch the Chenille Cat

1. Hoop your base fabric with a piece of
OESD Lightweight TearAway.
2. Cut four or more fabrics into 7" x 7" or
longer rectangles.
3. Stack the fabric squares and place them
on the hooped base fabric.

4. Embroider the Chenille lines (first color).
5. Remove the hoop from the machine, but
don’t remove the fabric from the hoop.
6. Using the Olfa® Chenille Cutter or
Clover® Slash Cutter, cut between the
rows of stitches.
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7. Place a piece of OESD AquaFilm
Topping on top of the Chenille Stitches
and place hoop back onto the
embroidery machine. Stitch the outline
of the cat (second color).
8. Remove the hoop from the machine, but
do not remove the fabric from the hoop.
9. Using appliqué scissors, trim close
to the outline stitches to eliminate the
excess that extends past the stitches.
10. Place another piece of OESD AquaFilm
Topping over the Chenille Stitches if
necessary.
11. Place the hoop back onto the
embroidery machine and embroider the
satin outline (third color).
12. Remove the fabric from the hoop and
trim close to the satin stitches being
careful not to cut the threads.

13. Spray the back of the cat with the 101
Quilt Basting Spray and place it on
your garment.
14. To add a tail, stitch down the layers of
fabrics the desired length for the tail.
15. Cut ¼" away on both sides of the
stitching. Slip the tail underneath the
cat.
16. Straight-stitch close to the inside edge
of the satin stitching to attach the cat
to your garment.
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33

BY LINDA LEE

Liberty Shirt Sleeve Vent
The Liberty Shirt pattern from Project Sewing Workshop has
many unique features, but one of the best is the deep vent at the
bottom of the sleeves. It’s cleanly finished so the sleeve can be
worn full length or turned up. The same technique can be used
for other applications such as pant and skirt hems.

3. With the sleeve turned inside out, turn the hem edge right
sides together at the vent opening, bringing the folded edge
to the end of the stitching. Stitch from the end of the previous
stitching to the hem foldline. Trim as shown.
4. Press the seam
allowances open
over a point
presser/clapper.
Turn the vent to
the right side and
press.

1. The Liberty Shirt has a 2½"-long finished vent opening, so the
sleeve length is 2½" plus a seam allowance longer than the
finished length of the sleeve.
2. Sew the sleeve seam, stopping the stitching at the top of the
vent opening. Press the seam allowances open.

5. Repeat steps 3
and 4 for the other
vent edge.
6. Turn the sleeve
right side out.
Stitching inside the
“tube,” topstitch the sleeve hem in place.
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Recommended Reading: More! Hand
Appliqué by Machine by Beth Ferrier for
the fine points of the appliqué process
outlined in this article.

BY BETH
BETH FERRIER
FER
F
ERRI
RIER
ER

Finished size: About 16" x 20"

Welcome spring with this lovely machine-appliquéd wall-hanging by Beth Ferrier, featuring
her new Wash Away Applique Sheets. Use this unique water-soluble product for the appliqué
templates, then wash it away or simply leave it in place to soften over time.
SUPPLIES
• ½ yard background fabric
(includes binding)
• Fat quarter (18" x 22") of
backing fabric
• Fat eighths (11" x 18"
pieces):
- Four greens for stems
and leaves
- Four to five blues for the
posies
- Pink for berries
- Yellow for the flower
centers
- Two tan/browns for the
flower pot
• Wash Away Appliqué
Sheets (about four sheets
required)
• Polyester Invisible thread;
Superior or Sulky brands
preferred
• Assorted 50 wt and 12 wt
cotton threads to coordinate
with the fabrics
• Neutral 50 wt cotton for the
bobbin
• Stapler and staple remover
• Water-soluble glue stick
• 18" x 22" rectangle of
batting
• Basic sewing supplies
• ¾" and 1" scrapbooking
circle punches make quick
work of the circles
• Spray sizing (optional)
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Making the Bias Stems

Overlapping the basted and unbasted edges, glue the flowers
together. Glue the flower pot parts together.

Find the 45° line on your ruler and align it with a straight edge on
the fabric you want to use for the stems. Make a 45°-angle cut.

Sew the flower motifs together before sewing them to the
background. This allows you to arrange them more easily on the
background. Use invisible thread and a small zigzag (SW = 1mm
and SL = 2mm) to stitch the smallest star. Pair the same stitch
with 50 wt cotton variegated thread on the flower’s medium
star, the leaves and stems and the berries. Use the same zigzag
setting for the circles on the flower pot, but use 12 wt cotton
thread. Use the same bobbin thread for all stitching.

Note: To get the most out of your fabric it’s good to make the
bias stems before cutting and creating the leaves.

Slide the ruler over to the right until the 1" line is aligned with the
freshly cut angle. Cut again to make a 1"-wide bias strip. You’ll
need two strips about 6" long for the center stem, two about 5"
long for the lower branches, and two about 4" long for the upper
branches.
Fold and press the bias strips into thirds, wrong sides together, in
the same way you would fold an 8½" x 11" piece of paper to put
into a business envelope. Use spray sizing to help the strip hold
its shape.

Prepare the Templates

Make photocopies of the full-size appliqué templates. Fold the
Wash Away Appliqué Sheets to make six layers. Staple the
individual photocopies to the folded sheets, placing one staple
inside each petal. For the quilt, you’ll need six flowers and twelve
leaves. Following the lines on the photocopies, cut out the leaves
and cut apart the posy and pot shapes. Staple the flower pot
shapes to a single layer of the Wash Away Appliqué.
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Stitch the Flowers Together

Assemble the Appliqué

Cut a 16" x 20" rectangle from the background fabric. Use a dab
of glue or straight pins to hold the stitched motifs in place on the
background.
Use the small zigzag used above and a small blanket stitch
(stitch #329 on the artista) to sew the decorative stitching on
the flowers and the flower pot (see photo).

Note: If you’re making copies using your home inkjet printer,
you can print the design directly onto the Wash Away Appliqué
Sheets.
Use the scrapbooking circle punches to create the perfect
¾" circle (for the berries) and 1" circle (flower pot decoration)
templates from the Wash Away Appliqué Sheets. You’ll need
seventeen of the smaller circles for the berries and seven of the
larger circles to decorate the flower pot.
Using a hot, dry iron, press the shiny side of the template
shapes to the wrong side of the fabrics you have chosen for the
appliqué. Cut out around the templates shapes adding about
¼" all around for turn-under seam allowances as you cut.

Glue Baste the Appliqué Pieces

Apply the glue stick to the exposed fabric seam allowances of
the berries and pot decoration circles. Using the template as a
guide, pinch the turn-under allowances, wrap them around the
template, and stick them in place. Do the same with the leaves.
For the flowers and flower pot, glue-baste only the edges of
the shapes that are in front of other shapes, or in front of the
background. Leave the parts of the shapes that are under other
shapes unturned and unbasted.
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Stitch the appliqué shapes to the background – use a blanket stitch for the flowers and flower pot, and a small zigzag for the stems, leaves
and berries.
There’s no need to remove the templates as you would with freezer paper foundations! As its name says, Wash Away Appliqué Sheets do
just that! Left in place, the templates will soften over time, or you can gently hand launder the appliquéd piece to remove them for a softer
finish.
Layer the quilt top with the batting and backing fabric. Stitch-in-the-ditch around the appliqués using a 12 wt cotton thread to outline the
shapes. Free-motion quilt a happy design on the background.
Using the remainder of the background fabric, cut about five 2" x 20" strips for the binding. Join the strips with diagonal seams and press
the seam allowances open. Fold the strip in half lengthwise, with wrong sides together; press. Apply to the edges of the wall hanging.

BETH FERRIER
Beth was given her
first sewing kit in
kindergarten, and has
been putting needle
to thread ever since.
A quilter since 1975,
it didn’t take long for
her to being designing her own patterns. A
teacher by nature, it was only a matter of
time before the quilting classes began. “It’s
important to me that every student come
away from my class eager for the next
challenge. I love what happens to a quilter’s
soul when she masters a new technique!”
Beth offers fun and informative classes and
seminars for beginning and experienced
quilters. Her original patterns are available
in quilt shops around the world. For more
information on Beth and her new book,
More! Hand Appliqué by Machine, visit
www.applewoodfarmquilts.com.
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ENLARGE FULL
TEMPLATE 200%
©2009 by Beth Ferrier for BERNINA of America’s Through the Needle magazine
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Walk
Beside
Me
BY LINDA WENTURINE

Supplies
• BERNINA 830
• 830 Embroidery Design CD
• BERNINA v6 Embroidery Software
• Jumbo Hoop
• Patchwork Foot #37D or
Patchwork Foot with Guide #57D
• 14" x 14" square of Fusible Fleece,
such as Pellon #987F
• OESD Polymesh Stabilizer
• 505 Spray Adhesive
• Two 7" x 7" squares of light fabric
• Two 7" x 7" squares of medium fabric

Finished size: 12½" x 15"

Use BERNINA v6 Embroidery Software to create quilting
motifs that make you look like a pro, and then combine your
designs with one of the built-in Diane Gaudynski quilting
motifs from the BERNINA 830. You’ll be well on your way
to making this beautiful wall hanging to customize with your
favorite inspirational quote.

• One 14" x 14" square of backing fabric
BINDING:
• Two 4" x 14" strips for the sides
• Two 4" x 16" for the top and bottom
• 1" x 12½" x ¼" wood strip
• Isacord embroidery thread in desired
colors
• Two 3½" tassels
• EZ-Glitzer and crystals
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Create the Embroidery Design
Open a New file. Right click on the Show Hoop
icon and select Jumbo Hoop #26. Click on the
Show Grid icon to display the grid.
Create the placement lines for the corner
squares: Select the Open Object Tool. Create
two lines that form a right angle for the corner.
Press Enter on the keyboard to set the stitches.

I S S U E

Open Object Properties and choose the General Tab. Change the size to 168 x 168mm.
Create your own
quilting design using
the Open Object
Tool and a series of
left (straight line) and
right (curved line)
mouse clicks. Be
sure to stay within
the placement lines.
If desired, use the
illustration as a
guide. Save.
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Repeat the hooping and stitching
sequence for each of the four corner
squares, alternating the quilting motifs.
Trim the PolyMesh close to the
embroidery stitches.

Open a New file. Create another pair of placement
lines. Open one of the Diane Gaudynski designs
from the CD included with your BERNINA 830. The
sample uses design DG10.
Select All, open Object Properties, and choose the
General Tab. Change the size to 168 x 168mm.
Save.
Open a New
file. Select
the Lettering
icon and type in your favorite inspirational quote
in the dialog box. Add decorative design motifs
as desired. The sample features #FQ522-48 from
the Floral folder in the My Designs – Embroidery
Software 6 folder.
Select the Hoop Layout tab. Select the hoop and
rotate it 90°.
Adjust the size of the text as needed to fit within
the embroidery field of the Jumbo Hoop.
Return to the Embroidery Canvas tab. Save.

Construct the Wall Hanging
Stitch the 7" squares together to form a small
four-patch quilt.
Fuse the fleece to the back of the quilt top.
Hoop a layer of PolyMesh stabilizer.
Embroider the corner placement lines on
the stabilizer.
Spray the PolyMesh with 505 spray
adhesive and align the quilt top within the
placement lines. Embroider the quilting
motif in one square.
When the embroidery is complete, remove
the quilt from the hoop.

Hoop a layer of PolyMesh and spray it
with 505 spray adhesive. Place the entire
quilt top in the center of the hoop.
Stitch the lettering on the quilt top.
Spray the back of the quilt top with 505
spray adhesive; adhere to the wrong side
of the backing fabric. Trim the backing
even with the quilt top.
Sew the 2"-wide binding strips to the
sides of the quilt using your preferred
method for attaching binding.
Turn under and press the short ends
of the 4"-wide binding strips to finish
the edges. Make sure these strips are
the same measurement as the top and
bottom edges of the quilt. Fold the strips
in half lengthwise, wrong sides together.
Press and then unfold the strips.
Sew one edge of a 4"-wide binding strip
to the back of the top edge of the quilt
using a ¼" seam allowance. Fold along
the pressed edge. Press under ¼" on the
remaining edge and topstitch to the front
of the quilt.
Repeat for the lower edge of the quilt.
Insert the wooden slat into the casing at
the top of the
quilt.
Add glitz as
desired using
the EZ-Glitzer.
Sew the
tassels to the
sides of the
quilt at the
upper edge.
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T hread-Painted
Flower Tote
BY JUDY HAHNER

What should I do with
all these perfectly cut
little posies? While
getting acquainted
with the new BERNINA
CutWork Tool and
Software, I experimented
with cutting ﬂower
shapes out of wool felt
and they were starting to
accumulate. So, with a
sketch pad in hand, the
creative process began.
The result is this tote
made from placemats,
embellished with threadpainted cutwork ﬂowers
sewn with the BERNINA
Stitch Regulator #42 and
Free Motion Couching
Foot #43.

Supplies
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• BERNINA CutWork Tool*
• CutWork Stitch Plate
• Freehand Quilting Foot #29/29C
• BERNINA Embroidery Machine
• 1/3 yard wool felt or three 9"x12"
rectangles of wool felt
• OESD Ultra Clean & Tear stabilizer
• 505 Temporary Spray Adhesive
• Two ready-made placemats
• Two 6½" x 11" strips of coordinating
fabric for handle carriers
• Two 6½" x 5½" pieces of fusible
interfacing
• Chalk wheel or chalk pencil

Cut the Felt Flowers
Use temporary spray adhesive to bond a layer of wool felt and a layer of OESD Ultra
Clean & Tear stabilizer. Hoop the layers in the Medium Hoop.
Turn on the embroidery system. Open the flower design.DRAW CutWork design file
from the USB stick and load into the embroidery machine.
Prepare the machine for using the BERNINA CutWork Tool following the instructions
included with the accessory. Remove the upper thread and needle from the
machine, and then insert the CutWork Tool. Attach the CutWork Stitch Plate and
attach Freehand Quilting Foot #29/29C.

• YLI Multi’s embellishment yarn
• Isacord variegated embroidery
thread
• Isacord thread to match placemats
• Superior Threads Bottom Line
bobbin thread
• Sharp/Microtex or Universal
needles, size 80/12
• Free Motion Couching
Foot #43
• BERNINA Stitch
Regulator #42
• Edgestitch Foot
#10/10C/10D
• Reverse Pattern Foot # 1/1C/1D
• Purse Handles

* The BERNINA CutWork Tool works
with the BERNINA 830, artista
(730E, 640E, 630E, 200E, 185E,
180E), aurora (450E, 440E, 430E),
and Deco 340 embroidery systems.

Using the
chalk lines as
a guide, begin
free-motion
couching at
the top of one
stem. Continue
couching,
creating the
stems, leaves,

Following the prompts on the embroidery screen, cut out
several flowers. Voila! You have perfectly cut shapes ready
for embellishing!

and base of the flowers.
Open the design.
Draw file

Hoop the fabric and
stabilizer

Position the cut flower shapes on the couched stems.
Attach the BERNINA Stitch Regulator #42 (BSR) with the
Open Metal Sole to the machine and thread the needle with
variegated embroidery thread. Wind a bobbin with Bottom
Line bobbin thread; insert it into the bobbin case and thread
the bobbin for embroidery. Lower the feed dog.

Cut flower shape with
CutWork Tool

Begin stitching
in the center
of the flower,
securing and
trimming the
thread tails.

Remove the cut flower
from hoop

Stitch the Flowers and Greenery
Insert a new needle into the sewing machine. Attach Free
Motion Couching Foot #43 and install the guide included
with the accessory. Select a straight stitch; set the length at
2.5 and the stitch width at 0.02. If your machine does not
allow for such a fine adjustment to the stitch width, set the
width at 0.

Begin stitching
from the
center, using
the straight
stitch to outline
the flower
shape.

Lower the feed
dog and make
sure the needle
is in the center
position. Thread
the needle with
thread that
blends into
the color of
yarn. Use the
threading loop
included with the accessory to pull the Multis yard through
the guide.
Position the cut
flower shapes
on one of the
placemats. Use
chalk to sketch
the stem and
leaves. Set the
flowers aside.

Continue
thread painting,
following the
contour of the
petal shape
and finishing
with a circular
motion in the
center of the
flower shapes.

Repeat for the remaining flowers.
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Stitch the Tote Seams
Attach Edgestitch Foot # 10D or10/10C/10D to the sewing
machine. Thread the needle and bobbin with a color to
match the placemats.
Select a ladder stitch (artista #702). Adjust the
settings for SL = 6mm and SW = 6mm. Engage the
securing function if available.
Make a mark on each short edge of a placemat, 1¼” from
the bottom edge. Place the placemats right sides together.
Position the edges against the center guide of the foot, one
on each side. Begin stitching at what will be the upper edge
of the tote and join the short sides of the placemats, ending
at the marked point. Secure the stitch. Repeat for the other
side.
Select triple stitch (artista #6). Adjust settings for SL
= 3.5mm and move the needle three positions to the
right.
Make a mark 1¼" from each bottom corner of the
placemats to mark the beginning and end of the bottom
seam. With right sides together, stitch the bottom seam of
the placemat, securing the stitches at the beginning and
end of the seam. Any stitching along the original placemat
edge should be enclosed in the seam allowances.
Attach Reverse
Pattern Foot
#1/1C/1D to the
machine. Match
the marks at the
bottom of the tote,
creating a small
triangle. Stitch
across the triangle,
“boxing” the
corners of the bag
to form a base.
Strengthen the
seam by sewing
a second row of
stitching ¼" to the
right of the first
stitching. Trim seam allowances close to the stitching and
finish the raw edge with a zigzag or overlock stitch.

Fold one fabric
carrier in half
around one of the
handles and baste
the layers together
¼" from the long
raw edges. Repeat
with the remaining
carrier and handle.
Mark the center
of each handle
carrier edge and
the center at
the upper front
and back of the
tote. Position the
handle unit on the
wrong side of the
tote front, with the
edge of the handle
unit approximately
½" from top edge
of the tote, center
marks aligned.
Stitch the carrier
in place, sewing
about 1/8" from the
edge of the carrier.
Repeat for the second carrier and handle.

Attach the Handles
To prepare the fabric carriers for the tote handles, fuse a
5½" x 6½" piece of interfacing to half of each 6½" x 11"
fabric strip.
Select a straight stitch (artista #1). Fold the fused fabric
rectangles in half lengthwise with right sides together. Stitch
¼" from the short sides of each folded strip. Clip the corners
to remove bulk and turn the strips right side out. Press the
seamed ends.
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Fold the handle units up toward the top edge of the
tote. Select a triple stitch (artista #6). From the right side,
topstitch along the edge of the tote and over the stitches
used to attach the handle unit.

FELTED CIRCLE PILLOW
I S S U E
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This project was
originally published
by BERNINA International
in Inspiration magazine,
No. 45,
Autumn-Winter 2009

A rainbow of colors takes this plain rectangular
pillow from boring to jazzy. With the help of the
Needle Punch Tool, you’ll be able to create the
irregular circles of yarn and roving in no time.
Cutting
Cut two 24" x 14" rectangles from the green fabric.

Felting
Apply fusible interfacing to
the wrong side of one fabric
rectangle to reinforce it. This
will be the front of the pillow.
Using a chalk pencil or fabric
marker, draw offset concentric
circles on the front of the pillow
as shown in the illustration.
Install the Needle Punch Accessory Set on the sewing machine. Needle punch the wool
roving into the pillow front using the drawn lines as a guide.

Materials
Construction
All seam allowances are ½".
Place the front and back pillow rectangles right sides together. Sew the lower edges
together for 1" only at each end, leaving an opening in the center for the zipper. Press
the seam allowances open.
Using Zipper Foot #4 or Zipper Foot with Guide #14, insert the zipper into the opening
at the lower edge of the pillow.
Open the zipper halfway. With right sides together, stitch the side and upper edges of
the pillow cover together. Turn it right side out and insert the 24" x 14" pillow form.

• ½ yard green cotton fabric,
54" wide
• Wool roving for felting in
purple, white, red, light green,
orange and light blue
• 22” zipper
• Fusible interfacing
• Chalk pencil or fabric marker
• Needle Punch Accessory Set
• Zipper Foot #4 or Zipper Foot
with Guide #14
• 24” x 14” pillow form
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Embroidered
BY DEBBI LASHBROOK

Vest

Use My Label 3D Fashion
Pattern Software to design
and embellish a vest that
fits!

When embroidering on
leather, avoid dense
designs. Too many needle
penetrations will cut the
leather and ultimately cause
the embroidery design to
pull away from the rest of
the project. Increase the
stitch length for the same
reason. Light, airy designs
are best for leather. Outline
designs with medium to long stitches can also be used, as can satin
stitches that have been altered to have a low density. This simple little
vest is the perfect choice for a first embroidery-on-leather project.

PREPARING THE DESIGN
Open the BERNINA Embroidery Software. Open design # FB 331 from
Flourishing Appliqués, pack # 12205. Select the design.
Select Object Properties > General tab. Change the width and length
dimensions to 90%. Click OK.
Ungroup the design.
Open Color Film and select the second color chip. Click on the Outline
Tab at the bottom of the screen and select Backstitch from the dropdown box.

SUPPLIES

• Flourishing Appliqués Embroidery Collection,
Pack #12205, Design #FB331_48
• BERNINA Embroidery Software
• Vest pattern from My Label 3D Fashion
Pattern Software
• PolyMesh Cut-Away stabilizer
• Universal needle, size 80 or 90
• Embroidery thread, 30- or 40-weight
• Magna Hoop (optional)
• Roller Foot #51 or Zigzag Foot with Sliding
Sole #52 or Walking Foot #50
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MY LABEL MAKES IT EASY

It is always easier to embroider on garments that you
make for yourself. There’s no need to remove the
lining or shoulder pads, or to undo and redo seams,
for example. Embroidery is just plain easier on flat
fabric pieces. There’s no worry about catching the
garment on the arm of the embroidery machine or
accidently stitching into a garment section hidden
underneath. The Embroidery Consultant in My Label
3D Fashion Pattern Software offers many tips and
tricks for embroidering on garments.
In My Label software you can experiment with the
placement of embroidery designs by selecting
a similar design and manipulating the scale and
placement of the design. The important thing is to
place the design placed in an approximate position
for the center of the design. The pattern piece will
print with a dotted rectangle around the design and
an “x” to mark the center of the embroidery box.

I S S U E

Open Object Properties and change the stitch length to 4mm.
Select Apply.
Select color #3 from the Color Film area. Select the Fill Stitch tab.
Change the satin spacing to 0.65. Click Apply.
Select color #1 from the Color Film area and change the satin
spacing to 0.65. Click Apply.
Select colors #4 and #5 by holding the Control key down and
clicking on both color chips. Select the Triple stitch from the drop
down menu and change the stitch length to 4 mm. Click OK.
Save the file as Leather Embroidery.
Print a template of the design.

STITCHING THE DESIGN
Hoop a layer of PolyMesh Cut-Away
stabilizer. Spray with 101 Quilt Basting
Spray and finger press the leather into
place. Do not hoop leather as it will
show hoop marks.
A great embroidery accessory for

TIPS FOR SEWING LEATHER
When selecting leather, be sure to examine the skins carefully. Higher
grades of leather have fewer scratches, holes, and flaws. The skins
will cost more, but you will have less waste. Garment leathers range
from 1/64 to 1/16”. Home sewing machines can successfully handle
leather weighing two ounces, which means that one square foot of
leather weighs 2 ounces.
Leather doesn’t have a true grainline, but the least stretch and
greatest strength are parallel to the backbone of the animal. Make
sure you examine the leather for imperfections before cutting. Use
a single-layer layout, with the right side of the leather facing up.
Remember to reverse the pattern pieces so that you are sure to have
both right and left sides, or, better yet, trace additional pattern pieces
so you have both right and left side pattern pieces. Use pattern
weights with a rotary cutter and mat to cut the leather.
Leather is easily marred by pins, so when
constructing the vest, use alligator clips
to hold the garment sections together.
Remove these as you sew the seams.
For garment leather construction, use
a size 70 or 80 needle for lightweight
skins, 90 for medium weight, and 100
for heavyweight. A Leather (wedge point)
needle is not necessary for lightweight
leathers. Use a wedge point needle if you get skipped stitches when
sewing with a Universal needle or when stitching through many
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hooping hard-to-hoop fabrics is the Magna Hoop. It is highly
recommended for leather fabrics to avoid hoop burn. Five acrylic
frames are included with 4 magnets, target stickers, a DVD, and
instruction manual. What a great embroidery accessory this is for
difficult to hoop fabrics!
Use the printed template of the design to locate and mark the
desired center of the design on the vest front.
Insert a Universal needle into the machine; do not use a Leather
needle. Use the smallest needle size possible – 40-weight thread
can be used with a size 80 needle, or a 30-weight thread with a
size 90 needle for increased coverage with decreased density and
stitch length.
Reduce the needle tension slightly. Embroider the design, stitching
at a reduced speed. (If your machine has a half speed function,
engage it for embroidery on leather.)
Assemble the vest according to the instructions in My Label.
Added instruction to vest construction; after sewing the armscye
seams, center front seams, and neckline seams of the vest to the
lining, turn the vest right side out before stitching the side seams.

layers. Leather is permanently marked by needle penetrations—make
sure you stitch accurately so you do not have to re-stitch the seams.
Use a stitch length of 2.5 to 3mm for
construction seams; 3 to 4mm for
topstitching. It is best to use a straight
stitch throat plate. Use Roller Foot #51
or Zigzag Foot with Sliding Sole #52 for
sewing leather. These feet will feed the
fabric easily through the machine. Another
option is Walking Foot #50. In addition,
you may wish to decrease the presser foot
pressure and stitch more slowly.
Leather is easily damaged by steam and
a hot iron. If you must press leather, use a
dry iron with medium temperature. You can
protect the leather with brown craft paper
while pressing. Seams are usually glued
open; rubber cement or leather glue can be
used. When gluing curved seams, as in the
princess
seams of
the My Label vest, place the garment
over a pressing ham to maintain the
shape of the curve.
A small wooden pizza roller can be
used to roll the seams flat after gluing.
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NEW PROJECTS!
Visit www.berninausa.com often to download FREE projects and lessons.
Recent offerings include Hawaiian Appliqué with the new CutWork Tool, plus
new 8 Series, DesignerPlus, and Explorations projects. Be sure to look for
the latest Quick on Your Feet postings for exciting specialty feet projects.
Go to: www.berninausa.com>Learn It
SEWLEBRITY SCRAPBOOK
Find out who’s sewing with Bernina! The most talented textile artists and
teachers turn their ideas into creations using BERNINA sewing equipment.
Go to: www.berninausa.com>Sewlebrity Scrapbook
Sarah Vedeler

FREE EMBROIDERY DESIGN DOWNLOADS
New FREE embroidery designs are posted monthly!
Go to: www.berninausa.com>See It/Share It

JOIN BERNINA WEBINAR EVENTS!
Hosted by talented BERNINA Educators, BERNINA Webinars are an innovative way to
learn more about the exciting family of BERNINA products, from the BERNINA 8-Series
Machines to My Label to DesignerPlus V6 Embroidery Software and more!

Log on and see
what’s new at
www.berninausa.com
www.berninabsr.com
www.berninaUSAblog.com
www.berninaMyLabel.com
www.bernina8series.com

To join the free BERNINA Webinar Events, visit www.berninausa.com. Invitations to
upcoming BERNINA Webinar Events are posted on the Home page throughout the month.
BERNINA QUILT FRAME – INSTRUCTIONAL VIDEOS
The BERNINA Quilt Frame is expandable to fit quilts of any size
from crib to king! It’s easy to assemble - just follow our step-bystep Instructional Assembly Video Clips. PLUS, learn step-by-step
how to load your quilt, batting and backing on the frame. Get ready
to experience the joy of quilting on the BERNINA Quilt Frame!
Go to: www.berninausa.com>In The Spotlight

BERNINA BLOG
Visit www.berninaUSAblog.com for sewing
news, tips & tricks, projects, and contests.
Even if you don’t yet own a BERNINA, you’ll
find inspiration for
your future sewing
adventures.

STORE LOCATOR
Looking for a BERNINA store near you? Use our Dealer Locator at
www.berninausa.com.

Logg on,

, and
an

ALEX ANDERSON

Y
You’ll
also find free BERNINA educational videos detailing
d
the use of BERNINA presser feet and accessories.
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RICKY TIMS

